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INTRODUÇÃO
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Introdução

● Google tem investido bastante em pesquisas 
na área de Inteligência Artificial (IA).

● Ferramentas:
– TensorFlow.
– Colaboratory.
– Ambas são ferramentas código-aberto (open 

source).
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O que é o COLAB?

● É um ambiente aberto de desenvolvimento de 
notebook Jupyter que roda totalmente em nuvem.

● Não demanda uma configuração.
● Os notebooks criados podem ser 

simultaneamente editados por todos os membros 
da equipe.

● Suporta as principais bibliotecas de 
aprendizagem de máquina (machine learning).
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Principais Recursos

● Escrever e executar código em Python.
● Documentar o seu código para suportar equações 

matemáticas.
● Criar, enviar e compartilhar notebooks.
● Importar e salvar notebooks do/para o Google Drive.
● Importar e publicar notebooks do GitHub.
● Importar external datasets (ex: Kaggle).
● Integrar código do PyTorch, TensorFlow, Keras e OpenCV.
● Serviço de nuvem gratuito com GPU.
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PRIMEIROS PASSOS
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Primeiro Notebook

● O usuário precisa estar conectado ao Google.
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Primeiro Notebook

● Passo 1: o usuário deve abrir a URL abaixo no 
navegador.
– https://colab.research.google.com

https://colab.research.google.com/
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Primeiro Notebook

● Passo 2: Clique em New Notebook. 
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Primeiro Notebook

● Passo 3: A interface estará pronta para 
codificação.
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Primeiro Notebook

● Passo 4: 
– Por convenção, o notebook terá o nome de 

Untitled0.ipynb.
– Para renomear, basta editar este nome padrão.
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Codificação

● Segue abaixo um código trivial em Python.
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Execução

● Para executar o código, clique na seta à 
esquerda da janela do código.
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Execução

● Para limpar a saída da execução do programa, 
basta clicar.
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Adicionando Células de Código

● Para inserir uma célula de código:
– Insert → Code Cell

● Uma outra alternativa:
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Adicionando Células de Código

● Digitando o código na nova célula:
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Executando Todo Código

● Para executar o código inteiro (todas as 
células) sem interrupção, basta usar a opção 
do menu:
– Runtime → Reset and run all
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Mudando Ordem Células

● Quando o notebook tem muitas células, é 
possível que o programador precise alterar a 
ordem de execução.

● Isto pode ser feito selecionando as células para 
CIMA ou para BAIXO.
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Apagando Células

● Em muitas situações, o programador pode 
precisar apagar as células de código.



 

20/84

DOCUMENTAÇÃO DO CÓDIGO
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Documentação de Código

● Python possui instruções para deixar código 
comentado.

● Porém, em muitas situações, o programador 
precisa mais do que texto simples para 
documentar os algoritmos de Aprendizagem de 
Máquinas (AM).

● As células de texto usam uma linguagem de 
marcação (markdown).
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Exemplos de Marcação

● Algumas maneiras de mudar a formatação do 
texto:
– **negrito**
– *italico*
– ~riscada~
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Equações Matemáticas

● As equações matemáticas são baseadas na 
sintaxe de Latex.

● Exemplo:
– Adicione uma célula de texto.
– Adicione o seguinte texto:

$\sqrt{3x-1}+(1+x)^2$
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Equações Matemáticas

● Outro exemplo:
– $e^x=\sum_{i=0}^\infty \frac{1}{i!}x^i$
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Equações Matemáticas

● Existem sites que facilitam a criação dessas 
fórmulas.

● CODECOGS
– https://latex.codecogs.com

https://latex.codecogs.com/
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GRAVANDO SEU TRABALHO
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Onde Gravar?

● COLAB permite gravar o trabalho no Google 
Drive ou no GitHub.
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Google Drive

● COLAB permite gravar o notebook no Google 
Drive.

● Opção no menu:
– File → Save a copy in Drive
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Google Drive

● Salvar no Google Drive permite que você 
acesse e/ou compartilhe com outras pessoas 
posteriormente.
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GitHub

● É possível salvar todo o seu trabalho no 
GitHub.

● Opção no menu:
– File → Save a copy in GitHub
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GitHub

● É necessário ter uma autorização (login) no 
GitHub.
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GitHub

● É necessário criar um repositório no GitHub.
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COMPARTILHAMENTO DE NOTEBOOK
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Compartilhamento

● O compartilhamento do notebook pode ser feito 
através do Google Drive.

● Para publicar o notebook para o público em 
geral, você pode compartilhá-lo através do 
repositório do GitHub.
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Compartilhamento

● O compartilhamento é feito através do botão 
(canto superior à direita).
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Compartilhamento

● Existem várias opções de compartilhamento:
– Para um grupo específico de pessoas.
– Colegas da sua empresa (equipe).
– Qualquer pessoa que possua o link.
– O público em geral.
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COMANDOS DE SISTEMA
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Comandos de Sistema

● Jupyter permite a execução de vários 
comandos disponíveis em sistemas 
operacionais.

● O COLAB dá suporte a esse recurso.
● Esses comandos são iniciados com o sinal de 

exclamação (!).
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Baixando Dados Remotos

● O comando WGET permite baixar (download) 
de arquivos remotos.

● Executar o comando:

!wget http://tiagodemelo.info/datasets/dados-curso.csv
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Baixando Dados Remotos

● O arquivo ficará disponível no Google Drive.

● Esse arquivo pode ser lido (usado) através da 
biblioteca Pandas:
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Baixando Dados Remotos

● Resultado:
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Baixando Dados Remotos

● Uma outra maneira de baixar os arquivos é 
usar os recursos da biblioteca Pandas para 
baixar o arquivo diretamente.
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Clonando Repositório Git

● É possível clonar o repositório inteiro do GitHub 
utilizando o comando git.
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EXECUTANDO ARQUIVOS EXTERNOS DE 
PYTHON
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Arquivos Externos (Python)

● Suponha que você já tenha desenvolvido 
alguns programas em Python e que estejam no 
Google Drive.

● É possível executá-los no COLAB.
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Montar Drive

● O primeiro passo é montar o Google Drive.
● Opção no menu:

– Tools → Command palette
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Montar Drive

● Uma célula de código será automaticamente 
criada.

● Se você executar o código acima, será 
solicitada uma autenticação.
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Montar Drive

● Basta clicar no link e fazer a autenticação:
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Montar Drive

● Autenticação:
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Montar Drive

● Autenticação:
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Montar Drive

● Será gerado um código automaticamente:

● Copia o código e cola na solicitação:
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Montar Drive

● Confirmada a autenticação:
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Execução do Código Python

● É possível listar os arquivos em um 
determinado diretório:

● A execução do programa:
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GRÁFICOS
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Gráficos

● COLAB dá suporte a sofisticados tipos de 
gráficos.

● Exemplo:
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Gráficos

● Saída do exemplo (código) anterior:
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AJUDA (HELP)
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Help

● As ferramentas de IDE costumam usar ajuda 
sensível ao contexto.

● Também recursos como auto-completar.
● COLAB possui todos esses recursos que 

facilitam a atividade de programação.
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Lista de Função

● Passo 1
– Abra um novo notebook ou uma nova célula de 

código e digite o código abaixo:

import torch

● Passo 2
– Digite o código abaixo:

Tensor = torch.
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Função de Documentação

● COLAB fornece documentação sobre qualquer 
função ou classe como ajuda ao contexto.

● Digite o código abaixo:

Tensor = torch.cos(
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COMANDOS MÁGICOS
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Comandos Mágicos

● COLAB possui um conjunto de comandos de sistema que ampliam 
as funcionalidades.

● Tipos:
– Linhas mágicas (line magics).
– Células mágicas (cell magics).

● Linhas mágicas:
– Única linha de comando.
– Código usa (%) no início do comando.

● Células mágicas:
– Atua para toda a célula de código.
– Código usa (%%) no início do comando.
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Linhas Mágicas

● Exemplo 1:
%ldir

● Exemplo 2:
%history
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Células Mágicas

● Uso de recursos de HTML.
● Exemplo:
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Lista Mágica

● Comando para verificar a lista de comandos 
mágicos:

%lsmagic
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FORMULÁRIOS
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Introdução

● COLAB provê um recurso bastante 
interessante de formulários.

● Os formulários podem ser usados para receber 
a entrada (input) de dados de usuários em 
tempo de execução.
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Inserção de Formulários

● Passo 1:
– Adiciona o formulário.
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Inserção de Formulários

● Passo 2:
– Botão de configuração (ícone de caneta).
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Inserção de Formulários

● Passo 3:
– Adicionar formulário:
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Inserção de Formulários

● Uso do formulário:
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Entrada de Texto

● Para aceitar a entrada de texto como 
parâmetro, basta alterar o tipo de dados.

● Exemplo:
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Lista de Dados

● É possível usar o formulário com lista de 
dados.

● Exemplo:
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Entrada de Datas

● É possível usar a entrada de datas.
● Exemplo:
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INSTALAÇÃO DE PACOTES AVANÇADOS
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Introdução

● COLAB suporta a maioria das bibliotecas de 
machine learning disponíveis.

● A instalação é similar ao ambiente Linux.

!pip install

!apt-get install
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Keras

● Escrita em Python e executar usando 
frameworks como TensorFlow ou Theano.

● Permite rápida prototipação de aplicações 
usando redes neurais.

● Suporta uso de GPU.

!pip install -q keras
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PyTorch

● Pacote bastante usado no desenvolvimento de 
aplicações com redes neurais.

!pip3 install torch torchvision
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GPU
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Introdução

● Google fornece o uso gratuito de GPUs.
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Configuração  GPUs

● Para usar o recurso de GPU:
– Runtime → Change runtime type
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Listando Dispositivos

● É possível descobrir (listar) os dispositivos 
usados pelo seu notebook na nuvem.

● Exemplo (CPU):
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Listando Dispositivos

● Exemplo (GPU):
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Memória

● É possível checar os recursos de memória 
através do comando abaixo:

!cat /proc/meminfo
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